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Tässä oppaassa esitellään Sibeliuksen keskeisimmän valikon, 

 

Create

 

, toimintaa. 
Valikko avataan tavanomaisesti ikkunan yläreunasta, mutta se voidaan avata myös 
riippumatta siitä missä kohtaa hiiri on pitämällä 

 

Ctrl

 

-nappulaa alhaalla, kun hiiri 
painetaan pohjaan (Mac), tai hiiren oikeanpuoleisella näppäimellä (Windows). 
Valikon komennoilla tuotetaan tahteja ja tahtimerkintöjä, graafisia merkkejä, 
tekstikenttiä, jne.

Komennot toteutetaan kahdella eri tavalla: Jos jokin tahti tai tahdinosa 
on aktivoitu, komento kohdistuu kyseiseen kohtaan. Jos aktivointia ei 
ole tai komento ei sitä tarvitse, muuttuu nuoli komennon jälkeen sini-
seksi, jolloin komennon toimenpide osoitetaan nuolen avulla halut-
tuun paikkaan – komento tipautetaan paperille.

 

Näppäinoikotiet. 

 

Komennot käydään läpi aakkosjärjestyksessä ohjel-
man valikon mukaisesti. Esittelyn myötä tulee myös vaihtoehtoina 
näppäinoikoteiden käyttö. Tällainen ilmaistaan Macintoshissa 

 



 

 -
merkillä. Kun komento voidaan siis suorittaa pitämällä 

 



 

 -näppäintä 
pohjassa sekä painamalla ao. kirjainta on esitys esimerkiksi seuraavan-
lainen 

 



 

-

 

B

 

. Windows-käyttöjärjestelmässä vastaava menettely tehdään 
Ctrl-näppäimen avulla (siis Ctrl-

 

B

 

). Lyhyyden vuoksi vain Macintosh-
merkintä on käytössä. Pelkkä lihavoitu kirjain ilmaisee, että komennon 
voi tehdä painamalla yhtä kirjainta. Esimerkiksi 

 

Q

 

-kirjain avaa nuot-
tiavainikkunan. Valikoisssa tai valintaikkunoissa esiintyvä englannin-
kielinen teksti ilmaistaan kursivointina. Kun valikosta otetaan jokin 
kometo tai mennään alavalikkoon, käytetään toimenpiteestä > -merk-
kiä. 

 

Create>Barline>Start Repeat

 

 tarkoittaa sitä, että ensin avataan 

 

Cre-
ate

 

-valikko, valitaan sieltä 

 

Barline

 

, jolloin avautuu apuvalikko. Sieltä 
valitaan 

 

Start Repeat

 

. 

 

Create

 

-valikon komentoja on mahdollista muokata. Tähän työkalut 
löytyvät 

 

House Style

 

 -valikosta. Kyseiset toiminnot käsitellään toisaalla.

 

1. Bar

 

Bar-komennosta avautuu alavalikko, jossa on kolme vaihtoehtoa:

 

1.

 

At End

 

 lisää tahteja kappaleen loppuun. Tämä on tehokkainta toteuttaa varsin-
kin näppäinoikotienä 

 



 

-

 

B

 

. Kokeile pitää näppäimiä pohjassa pitempään ja 
Sibelius juoksuttaa tyhjiä tahteja nuottisivulle vauhdikkaasti.

 

2.

 

Single

 

 aktivoi nuolen ja voit tipauttaa tyhjän tahdin keskelle partituuria. Klikkaa 
tahtia, jonka eteen haluat tyhjän tahdin. Toinen vaihtoehto on aktivoida 



 

Barline
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tahdinosa halutussa tahdissa ja sen jälkeen hakea valikon komento, jolloin uusi 
tahti ilmestyy.

 

3.

 

Other

 

-komennolla voit määrätä montako tahtia haluat nuolen kanssa tehdä. 
Siellä on vaihtoehtona tehdä tahtiosoituksen tai poikkeavan mittaisia tahteja. 
Kun 

 

Irregular

 

 on valittu, kerätään ponnahdusvalikosta aika-arvoja haluttu 
määrä. Esimerkissä ollaan luomassa kolmen kahdeksasosan mittaista tahtia.

Uusi tahti tipautetaan nuottisivulle nuolella samaan tapaan kuin edellä.

 

Poista tahti. 

 

Osoita 

 



 

-näppäin pohjassa haluttua tahtia, sen ympärille tulee kak-
sinkertainen sininen kehä. Poista tahti 

 

Delete

 

-näppäimellä, ja koko tahti häipyy. 
Tahdin sisältö sen sijaan poistetaan siten, että osoitetaan tahtia (ei 

 



 

-näppäintä), 
jolloin siihen tulee yksinkertainen kehä. 

 

Delete

 

 poistaa tahdin sisällön.

 

2. Barline

 

Sibelius tekee tavalliset tahtiviivat automaattisesti sekä laittaa kappaleen loppuun 
paksun kaksoisviivan. 

 

Barline

 

-komennon takana on alavalikko, jonka avulla voi-
daan luoda erilaisia tahtiviivoja. Niistä kooste seuraavassa kuvassa. 

Valitse sopiva tahtiviiva ja pudota se nuolella haluttuun paikkaan. Tahtiviivan voi 
laittaa muuallekin kuin korvaamaan alkuperäistä, esimerkiksi keskelle tahtia.

Tahtiviiva yhdistää eri stemmoja ja tätä yhdistelyä voi muuttaa seuraavasti: osoita 
joko tahtiviivan ylä- tai alapäätä ja sininen neliö ilmestyy. Raahaa neliötä ylös tai 
alas ja tahtiviiva muuttaa mittaa.



 

Clef
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3. Clef

 

Nuottiavaimia tehdään samalla tavalla kuin tahtiviivojakin, 

 

Create>Clef

 

-komen-
nolla avautuu ikkuna, jossa on eri vaihtoehdot tarjolla. Näppäinoikotie on 

 

Q

 

. 
Tipauta avain sopivaan paikkaan. Jälleen avain voidaan laittaa myös aktivoimalla 
tahdinosa ja sitten valitsemalla sopiva avain. Avain voidaan poistaa aktivoimalla se 
ja painamalla 

 

Delete

 

.

Avainta voi siirtää hiirellä. Liikuttele avainta, samalla nuotit transponoituvat auto-
maattisesti. Jos avain vaihtuu rivinvaihdon yhteydessä, edellisen viivaston loppuun 
tulee avain huomauttamaan vaihdoksesta. Tuon avaimen saa pois näkyvistä siten, 
että ensin valitset tarpeettoman avaimen, sitten komento 

 

Edit>Hide or Show>Hide

 

 
tai 

 



 

-

 

Shift

 

-

 

H

 

.

Valintaikkunan teksti 

 

Draw on subsequent staves

 

 kannattaa yleensä jättää voimaan. 
Jos valintaneliön tyhjentää, avain ei ilmesty seuraavien viivastojen alkuun.

Partituurin kaikki avaimet kätketään aktivoimalla tahti ja sitten poistamalla merkki 

 

Propeties

 

-ikkunan 

 

Bars

 

-paneelin valintaneliöstä 

 

Clefs

 

.



 

Graphics
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4. Graphics

 

Nuottisivulle voi sijoittaa kuvia sillä edellytyksellä, että kuvat on tallennettu TIFF-
formaattiin. 

 

Create>Graphic

 

 avaa valintaikkunan, jonka avulla haetaan haluttu 
kuva. Jos jokin tahdinosa on valmiiksi aktiivinen, kuva ilmestyy siihen kohtaan, 
muutoin kuva tipautetaan nuolen avulla paikalleen. Kuvaa voi siirrellä ja venytellä 
hiiren avulla. Mikäli on syytä palauttaa muokkauksen jälkeen kuva ennalleen, vali-
taan 

 

Layout>Reset Design

 

 (

 



 

-

 

Shift

 

-

 

D

 

). Kuva poistetaan aktivoimalla se ja paina-
malla 

 

Delete

 

-näppäintä.

Jos samaa kuvaa käytetään useasti samassa dokumentissa, on syytä kopioida ja 
sijoittaa se mieluummin kuin tuoda se dokumenttiin uudelleen. Tällä tavoin doku-
mentin koko ei tarpeettomasti kasva.

 

5. Guitar frame

 

Kitaran sointuotteet tehdään 

 

Guitar frame

 

 -komennolla (näppäin 

 

U

 

). Valitse sointu 

 

Key

 

- ja 

 

Type

 

-valikoista, basson sävel määritetään 

 

Bass

 

-valikosta. Valintojen mukaan 
Sibelius näyttää joukon erilaisia vaihtoehtoja, joita voi poimia osoittamalla. 

 

Max. 
stretch

 

 rajaa sointuvaihtoehdot sen mukaan, kuinka monen nauhan yli sointuote 
voi venyä. Haluttu sointu ilmestyy ikkunan oikeanpuoleiseen kenttään, jossa sitä 
voi vielä muokata.

Otteen nauhoja osoittamalla voi sointuotetta muokata, soinnun yläpuolella voi 
määritellä kielen avoimeksi tai mykistetyksi. Lisäksi nauhaa pitkin nuolta raahaten 
voi tehdä 

 

barré

 

-otteita. 

 

Show chord symbol

 

 -kentässä voi muuttaa sointumerkkiä ja 

 

Fret

 

-nuolilla vaihdetaan nauhamerkintää.

Vasemman puoleisen kentän alaosassa on 

 

Tuning

 

-valikko, josta voi vaihtaa soitti-
men viritystä.

Huomaa, että itse sointuote ei transponoidu, jos kappaleen sävellajia muutetaan 
myöhemmin.

 

6. Highlight

 

Viivaston jokin osa voidaan korostaa keltaisella värillä. Aktivoi haluttu alue ja 
valitse 

 

Create>Highlight

 

. Korostettua aluetta voidaan siirtää hiirellä raahaten. Sitä 
voidaan venyttää tarttumalla alueen reunaan ja se voidaan poistaa osoittamalla 



 

Instruments
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alueen reunaan ja painamalla 

 

Delete

 

-näppäintä. Korostetut alueet voidaan kätkeä 
komennolla 

 

View>Highlights

 

. Normaalisti korostettu alue ei tulostu. 

 

7. Instruments

 

Kappaleeseen voidaan milloin vain tuoda uusia soittimia 

 

Create>Instruments

 

 
-komennolla (näppäin 

 

I

 

). Avautuva ikkuna on sama kuin uutta kappaletta 
tehtäessä. 

 

Add in normal order

 

 -valintaneliöstä voit valita, tuleeko soitin standardin 
mukaiselle paikalle, vai tipautatko soittimen parti-
tuurissa haluamaasi paikkaan. Voit myös valita, 
onko soitinperheestä näkyvillä yleisimmät vai 
kaikki ohjelman tuntemat soittimet.

 

Treble staff

 

 ja 

 

Bass staff

 

, jotka löytyvät 

 

Others

 

-ryhmästä soveltuvat esimerkkien kir-
joittamista varten. Nämä viivastot ilmestyvät ilman viivastonimeä.

 

Tuhoa viivasto. 

 

Instrumentti poistetaan kolmoisosoittamalla (töks-töks-töks) tah-
din tyhjään kohtaan. Viivasto saa kauttaaltaan sinisen kehän. Tämän jälkeen paine-
taan 

 

Delete

 

-näppäintä.

Soittimen nimen voi muuttaa osoittamalla alkuperäistä nimeä ja kirjoittamalla 
uuden tilalle. Soittimen nimi muuttuu koko partituurissa. Nimen sijaitia voidaan 
muuttaa tavalliseen tapaan hiirellä raahaten.

 

8. Key Signature

 

Tällä komennolla (

 

Create>Key Signatures

 

 tai 

 

K

 

) voi vaihtaa etumerkintöjä. Duuri- 
ja mollivaihtoehto kannattaa valita tilanteen mukaan, sillä sen perusteella mää-
räytyy tiettyjen kromaattisten nuottien kirjoittaminen. Sävellajimerkintää voi siir-
tää nuolinäppäimillä tai hiirellä ja aktivoitu merkintä poistuu 

 

Delete

 

-näppäimellä.

 

Hide

 

-komento kätkee sävellajin merkinnän. Yksittäinen viivasto voi saada muista 
poikkeavan (polytonaalisen) sävelajimerkinnän komennolla 

 

One staff only

 

.

Jos sävellajin vaihto osuu uuden viivaston alkuun, tulee muutoksesta huomautus 
edellisen viivaston loppuun. Sen voi kätkeä aktivoimalla tarpeeton merkintä ja 
valitsemalla komento 

 

Edit>Hide os Show>Hide

 

 tai 

 



 

-

 

Shift

 

-

 

H

 

.

9. Line Line-komennolla (kirjain L) aukeavasta ikkunasta valitaan erilaisia kaaria, trillejä ja 
glissandoja sekä kertauksien maalit. Huomaa, että osa merkeistä saadaan myös 
näppäinkomennoilla. Vasemman puoleisesta kentästä valitaan sellaisia merkkejä, 
jotka kohdistuvat yhteen stemmaan, siis esimerkiksi Legato-kaari. Oikean puoleisen 
kentän merkit, vaikka näyttäytvätkin partituurissa vain yhdessä kohtaa, toistuvat 
sitten stemmojen dokumenteissa. Esimerkiksi ensimmäinen maali piirretään parti-
tuuriin vain kerran, mutta silti se on mukana kaikissa erillisissä stemmoissa sittem-
min.



Rehearsal Mark
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Legato-kaaren teko. Aktivoi nuotti ja valitse Line-ikkunasta legatokaari tai käytä S-
kirjainta tai Shift-S alapuolista kaarta varten. Ohjelma tekee kaaren kyseisestä nuo-
tista seuraavaan. Pidennä sitä Välilyönti-näppäimellä, Shift-välilyönti saa kaaren 
vetäytymään takaisin päin. Hienosäätöä voi tehdä nuolinäppäimillä ja  -
nuolinäppäimellä kanssa vähän suuremmissa erissä. Voit laittaa kaaren ilman nuo-
tin aktivointiakin, mutta silloin se ei ole magneettinen eikä väistele älykkäästi 
muita merkintöjä, joten yleensä kaari laitetaan ensimmäisellä tavalla.

Kaaren muokkaus. Jos haluat myöhemmin muokata kaarta, toimi näin:

• oikeaan päähän osoittamalla voit muuttaa sen pään sijaintia nuolilla tai välilyönnillä

• vasempaa päähän osoittamalla voit siirtää kaaren alkua

• hiirellä voit muovata kaaren keskikohtaa

• Layout>Reset Position tai  -Shift-P siirtää kaaren oletuspaikkaan

• Create>Extra Slur Arc lisää kaareen uuden nivelen, jonka ansiosta voi piirtää kaareen 
lisää mutkia.

Legatokaari, joka jatkuu viivastolta toiselle ei piirretä kahtena merkkinä, vaan 
vedetään hiirellä suoraan päätöspisteeseen seuraavalla rivillä. Toinen vaihtoehto on 
käyttää välilyöntiä. (Huomaa, että Tie tarkoittaa yhdyskaarta kahden samankorkui-
sen sävelen välillä. Yhdyskaari on ohjelman Keypad-ikkunassa. Näitä kahta ei pidä 
käyttää toisen tilalla.)

Muut merkit Line-ikkunasta toimivat samankaltaisesti.

10. Rehearsal Mark Tällä komennolla (myös  -R) teet 
harjoituskirjaimia. Sibelius osaa 
pitää huolen oikeasta merkistä – 
myös jos jotain jaksoja poistetaan 
välistä.

Toinen mahdollisuus on aloittaa 
vaikkapa uudessa osassa merkintä 
alusta, silloin käytetään Start at -
vaihtoehtoa.

11. Symbol Kun tarvitaan erityismerkkejä, on Symbol-komennon (Z) alla 
niitä useita. Poimi tarvittava merkki ja tipauta se paikkaansa. 
Ne osaavat seurata nuottisivun muutoksia. Mutta jos haet 
sieltä käyttöösi esimerkiksi kromaattisen merkin, se ei muutu 
transponoinnin yhteydessä.

Merkin koko valitaan neljästä vaihtoehdosta: Normal (100%), 
Cue (75%), Grace note (60%), Cue grace (50%).



Text
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12. Text Keskeiset tekstit saa tietenkin näppäinoikoteinä:  -E esitysmerkkejä varten,  -T 
soittotekniikkaa varten ja  -L sanoitusta varten. Samat toiminnot löytyvät 
Create>Text-komennolla. Esitysmerkit ja tekniikat tipautetaan nuolella paikalleen, 
Sibelius sijoittaa tekstikentän automaattisesti viivaston oikealle puolelle, sen jälkeen 
painetaan hiirellä Ctrl-näppäin pohjassa, jolloin avautuu valikko eri vaihtoeh-
doista. (Valikon nimi on Word Menu. Windowsissa se avautuu hiiren oikealla pai-
nikkeella.) Kyseisen valikon sisältö vaihtuu sen mukaan, mitä tekstikenttää ollaan 
lisäämässä. Tekstiä voi lisätä myös kirjoittamalla. Esitysmerkkien lisäämisessä on 
vielä yksi oikotie: kun olet osoittanut merkin paikkaa, kirjoita esimerkiksi  -M ja 
 -F, jolloin mf-merkki tulee näkyviin. Kussakin valikossa on useita 
näppäinoikoteitä.

Sanoitus. Sanoituksen kirjoittaminen voidaan tehdä kahdella tapaa: tavu kerrallaan 
tai kopioimalla ja sijoittamalla valmis teksti melodian alle.

1. Tavu kerrallaan:
• valitse Create>Text>Lyrics tai  -L

• osoita ensimmäisen nuotin alapuolelle

• kirjoita tavu

• paina välilyöntiä tai tavuviivaa, ohjelma hyppää seuraavaan nuottiin.

2. Kopioimalla valmis teksti:
• luo sanoitus tavuttaen tekstinkäsittelyohjelmalla

• kopioi teksti

• aktivoi Sibelius-dokumentin melodiasta ensimmäisen tavun nuotti

• valitse Create>Text>Lyrics tai  -L

• paina  -V, jolloin ensimmäinen tavu ilmestyy nuotin alle, juoksuta samalla tavoin loput 
tavut

Tavujen paikkaa voi nuolella muuttaa. Kokeile seuraavaa: tee sana, jossa on kaksi 
tavua ja tavuviiva välissä, siirrä jälkimmäistä tavua reilusti oikealle, siirrä väliin jää-
nyttä tavuviivaa oikealle ja Sibelius luo lisää tavuviivoja täyttämään kahden tahdin 
välistä aukkoa.

Jos haluat siirtää kokonaisen rivin tavujen korkeutta, aktivoi ensimmäinen tavu ja 
komennolla Edit>Select>Select More loput tavut. Sen jälkeen voit nuolinäppäimillä 
säätää tekstin korkeutta.

Valikosta löytyy komennot myös säkeistöille 2-5. (Säkeistöt 3-5 ovat apuvalikossa 
Create>Text>Other Staff Text.) Lisäksi komennolla Create>Text>Other Staff 
Text>Lyrics above staff on mahdollista tehdä sanoitusta viivaston molemmille puo-
lille. Tällainen tyypillistä kuoronuoteissa.

Sointumerkit. Aiemmin oli puhetta sointumerkeistä, joissa on mukana kitaran ote-
lauta. Tavalliset sointumerkit tehdään seuraavasti:



Text
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1. Create>Text>Chord Symbol ( -K)
2. osoita halutun nuotin yläpuolella
3. kirjoita sointumerkki (b tekee alennusmerkin ja # korotusmerkin) tai
4. avaa Ctrl-näppäimen kanssa Word Menu -valikko, josta rakennetaan 

sointumerkit
5. välilyönnillä hypätään seuraavaan nuottiin

Other Staff Text. Apuvalikosta on mahdollista poimia erialaisia tekstikenttiä, 
kuten:

Footnote, alaviite. Alaviite osoitetaan tietyn viivaston tiettyyn tahtiin, mutta se 
ilmestyy kyseisen sivun alareunaan samalla tavalla kuin tekstinkäsittelyohjelmissa-
kin.

Fingering, sormitus. Kirjoita sorminumero, välilyönnillä siirrytään seuraavaan 
nuottiin.

Figured bass, kenraalibassomerkintä. Osoita ensimmäisen nuotin alla ja kirjoita 
numero(t). Kromaattiset merkit ovat  -7,  -8 ja  -9, muut merkit voidaan lait-
taa Word Menu-valikkoon. Välilyönnillä mennään seuraavaan nuottiin.

Title, Subtitle, Composer, Lyricist, Dedication. Kappaleen nimi, alaotsikko, sävel-
täjä, sanoittaja ja omistus ovat systeemitekstejä, jotka on valmiiksi tasattu joko 
sivun reunaan tai keskelle. Niinpä niitä ei voi siirtää kuin pystysuunnassa. Kappa-
leen nimen voi kirjoittaa minkä viivaston päälle tahansa

Tempo ja Metronomi. Tempo- ja metronomimääreitä ( -M) varten avautuu oma 
valikko Ctrl-näppäimen avulla. (Windows, hiiren kakkosnäppäin.) Tee sekä teksti 
että metronomiosoitus samaan kenttään, jotta myöhemminkin osoitus pysyy 
kuosissa. Jos nimittäin nuottikuvaa muokataan, saattavat erilliset merkinnät ajau-
tua toistensa päälle.

Merkintä saattaa ilmestyä partituurissa useampaan paikkaan ja yhtä liikuteltaessa 
sivusuuntaan toinen seuraa perässä. Myös merkinnän muutos peilautuu toisiin. 
Yksittäistä merkintää voi liikutella pystysuunnassa ja sen voi poistaa Delete-näppäi-
mellä.

Other System Text. Copyright liitetään kappaleen ensimmäiseen tahtiin, vaikkakin 
se ilmestyy ensimmäisen sivun alareunaan. ©-merkki löytyy Word Menusta.

Headers and Footers, ylä- ja alateksti. Header tekee oletuksena joka sivun yläreu-
nan keskelle saman tekstin, Header (after first page) jättää ensimmäisen sivun tyh-
jäksi. Footer-teksti tulee alas sivun ulkoreunaan ja Footer 2 alas sivun sisäreunaan. 
Ylä- ja alatekstit seuraavat myös partituurista irrotettuihin stemmoihin.



Time signature
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Special Text. Valikosta on mahdollista tehdä tekstikenttiä, jotka eivät noudata 
ohjelman tavallisia asetuksia. Esimerkiksi jos haluat tehdä kappaleen alkuun tekstin 
Intro samanlaiseen tyyliin kuin harjoituskirjaimet, valitse Create>Text>Special 
text>Rehearsal marks.Näin saat tekstin, joka on (oletuksena) lihavoitu 20-pisteinen 
ja laatikon sisällä

Tekstin kätkeminen. Kappaleen soittoa varten voi olla tarpeellista tehdä metrono-
mimerkintöjä tai dynamiikkamerkkejä, jotka eivät näy partituurissa. Teksti, joka 
alkaa tilde-merkillä (~), ei näy. Toinen vaihtoehto on kätkeä aktivoitu teksti komen-
nolla Edit>Hide os Show>Hide tai  -Shift-H.

13. Time signature Tahtilaji muutetaan tällä komennolla (tai kirjain T). Valitse sopiva tahtilaji, Other-
kenttään voi sommitella harvinaisempia tahtiosoituksia. Myös yhdistelmätahtilajit 
ovat mahdollisia, kirjoita esim. 5+3 ylempään kenttään. Sibelius osaa myös jakaa 
nuotit uudestaan tahteihin, jos tahtilajia vaihdetaan.

Allow cautionary sallii tahtilajin vaihtuessa huomautuksen edellisen viivaston 
lopussa. Kohotahti (Pickup) määritellään lisäämällä kenttään sopiva määrä nuot-
teja. Jos kohotahti tehdään myöhemmin, on käytettävä Create>Bar>Other 
-komentoa.



Tuplets
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Poikkeavien tahtila-
jien kahdeksasosat 
voidaan palkita mie-
leisellä tavalla. Esi-
merkissä on 7/4-
tahtilaji palkitettu 
kolmeen ryhmään.

Kahdeksasosat voi ryhmittää myös 
neljäsosien palkkeihin tavallisen 
puolinuottiryhmityksen tilalla.

14. Tuplets Triolit ja muut monijaot tehdään Create>Tuplet -komennolla:

1. laita triolin ensimmäinen nuotti viivastolle
2. näppää  -3 (tai kolmosen tilalla mikä tahansa 2-9 monijaosta riippuen)
3. kirjoita loput nuotit.

Toinen keino on käyttää valikkokomentoja: laita ensimmäinen nuotti

1. Create>Tuplet
2. kirjoita kenttään monijaon suhde-

luku
• Number laittaa nuottiryhmän päälle 

yhden numeron, Ratio koko suhdeluvun 
(esim. 5:3), Ratio + note lisää myös aika-
arvon suhdeluvun perään ja None jättää 
monijaon ilman merkintöjä.

• Auto-bracket yhdistää nuotit hakasella, 
jos nuotit eivät muuten ryhmity 
selkeästi. Tämä on ohjelman oletusarvo, 
sillä hakasta ei tarvita, jos meillä on esim-
erkiksi kolmen kahdeksasosan trioliry-
hmä. Bracket pakottaa hakaset joka 
paikkaan ja No bracket estää hakaset.

• Full duration venyttää hakasta 
seuraavaan nuottiin asti

3. OK
4. osoita monijaon ensimmäistä nuottia 

ja kirjoita loput nuotit.
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15. Tahtinumerot Varsinaisesti tahtinumerot määritellään House Style>Engraving Rules -komennolla. 
Valitse ikkunasta Bar numbers.Valintana on numero joka tahtiin, viiden tai kym-
menen tahdin välein, joka viivastoryhmän alkuun tai ei lainkaan. Center in the bar 
laittaa numeron tahdin yläpuolelle keskelle, Show at start of sections laittaa numeron 
myös ensimmäiseen tahtiin. Numeroinnin tyyli vaihdetaan Edit Text Style 
-komennolla.

Create>Bar Number Change -komennolla muutetaan automaattista tahtinumeroin-
tia esimerkiksi uuden jakson alussa. 

16. Bracket Hakaset tai akkolaadi partituurin viivastojen väliin tehdään seuraavasti:

1. Create>Bracket ja valinnan mukaan Bracket, Sub-bracket tai Brace
2. osoita viivaston vasemmalle puolelle
3. raahaa hakasta ylös tai alas yhdistämään viivastoja.

17. Extra Slur Arc Komento lisää kaareen uuden nivelen, jonka ansiosta voi piirtää kaareen lisää mut-
kia.

18. Extra Staff Osoita viivastoa ja lisää valikosta uusi viivasto aktivoidun ylä- tai alapuolelle. 

Ossiaa varten aktivoi tahti tai tahteja, joihin se liittyy, ja valitse valikosta Ossia 
Above tai Ossia Below.
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19. Staff Type Change Viivastoa rakennetta voi muuttaa missä kohtaa tahansa. Valittavana on vireinen, 
tabulatuuri ja rumpuviivasto. Vireisiä viivastoja on yksiviivaisesta viisiviivaiseen tai 
lopulta näkymättömään, tabulatuureja on erilaisille kielisoittimille, rumpuviivas-
toja useaan eri tilanteeseen. Valinnan jälkeen osoita partituurissa haluttuun paik-
kaan.

20. Transposition Change Ensimmäinen vaihto instrumenttien transponointia määritellessä liittyy transpo-
noituihin partituureihin. Yksiviivaisen c:n (C4) mukaan määritellään soittimen 
vire: mikä sävel tosiasiassa soi ja missä oktaavissa kun instrumentilla soitetaan c1?  

Toinen vaihtoehto määrittelee C-vireisten soittimien soivan oktaavialan silloin, 
kun soitin soi muussa oktaavissa, kuin se on kirjoitettu. Tällaisia soittimia ovat 
mm. basso, kitara, piccolo, sopraanonokkahuilu, tenoriääni, jne. Toisaalta Sibelius 
tekee nämä määrittelyt automaattisesti partituuria rakennettaessa, joten komentoa 
tarvitsee vain erityistapauksessa, kun luodaan Sibeliukselle tuntematonta soitinta.


